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In order to provide television and online service to you, we maintain 
business records that contain certain information about you.

I.�	� This information includes your name, address and telephone 
number; information about the services you subscribe to use; 
information about the equipment used to provide service to you; 
and accounting records reflecting payments you have made 
for services (“personal account information”). Except in the 
following circumstances, we do not make such personal account 
information available to others without your permission.

•	� Where necessary to perform maintenance or repair services, we 
may make your name, address, telephone number or services and 
equipment information available to qualified repair contractors 
or engineers.

•	� To perform auditing, bookkeeping, billing and collection functions, 
we may also make personal account information available 
to accountants, program providers, computer service bureaus 
and others engaged in maintaining, auditing or reviewing our 
financial records and in the billing collection of accounts. 

•	� When necessary to render services and related services to our 
subscribers, Qwest Choice™ TV & OnLine may also provide personal 
account information to other outside agents such as cable 
program guide distributors, customer satisfaction polling services 
or system testing services who assist us in providing service. 

•	� Qwest® is required to provide appropriate personal account 
information to governmental agencies if a court order is issued 
requiring us to do so. Unless directed not to, we will promptly 
inform any affected subscriber if we receive such an order. 

II.	�From time to time, Qwest may alert you by mail or telephone 
about our services or about other products and services that we 
think will interest our subscribers. Some of these offers will be 
for products or services we think may be of particular interest 
to you, based on the type of Qwest Choice TV & OnLine services 
that you purchase. On occasion, we are also asked by charities or 
businesses for the names, addresses and telephone numbers of 
subscribers to one or more of our services, so that those entities 
can contact subscribers to seek charitable contributions or to 
make offers of products or services. Our general policy is not to 
provide this information to others, although we can make certain 
exceptions where we believe the matter may be of particular 
interest to our subscribers. If you do not wish for us to disclose 
your name, address and telephone number to others for purposes 
not related to Qwest’s services, please contact us at the local 
number listed under section IV of the privacy policy.

Qwest Choice™ TV and OnLine Services
Customer Privacy Policy

Our business records contain information about our subscribers.
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III.	�Our business records containing personal account information are 
retained for the period that an individual remains a Qwest Choice 
TV & OnLine subscriber and are destroyed after the individual 
ceases to be a subscriber, all billing and collections functions 
are completed and record retention periods imposed by law 
have elapsed. Qwest employees, contractors and agents are 
permitted access to personal account information to maintain and 
repair your account, manage our overall network and business 
operations and to provide you with Qwest products and services. 
When Qwest agents or contractors access or use personal 
account information, they are bound by the same confidentiality 
commitments that Qwest makes to you here. They are fully 
trained in their obligation to maintain the confidentiality of such 

information and to prevent access by unauthorized persons. 

IV.	�You have the right to examine all personal account information 
that Qwest maintains. If you believe any of the information in  
our records is incorrect, we will make every reasonable effort  
to correct any error. Call the appropriate customer service 
number below. 

V.	� Federal law [47 U.S.C. 551 (f)] provides that, in addition to other 
remedies, subscribers to Qwest Choice TV & OnLine who believe 
their federal rights have been violated may institute civil suit 
in federal court. Remedies for violation of such rights include 
actual damages or liquidated damages (of up to $1,000), punitive 
damages and reasonable attorney fees and costs.

Qwest Choice TV & OnLine is committed to protecting  
your privacy rights. Qwest encourages you to regularly review 
these privacy rights online at qwest.com/legal/privacy or  
qwest.com/legal/choice_privacy.html as these rights are updated 
from time to time. Your continued use of the Service(s) constitutes 
your acceptance of any changes. To view the broader Qwest 
Privacy Policy with respect to noncable information, visit our Web 
site at qwest.com/legal/privacy.html. If you have any questions 
or concerns, please contact us immediately at the local number 
below. This document applies only to Qwest and to providers under 
contract to Qwest. Remember that the global Internet is not owned, 
managed or controlled by Qwest. Each Internet Service Provider 
sets and manages their own customer information policies. Qwest 
strongly recommends that you exercise appropriate caution in 
sharing personal information with service providers.

	 Phoenix Customer Service: 1 602-266-1700

	 Denver Customer Service: 1 303-383-9400

Customer Privacy Policy 
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On-time service calls 

We are committed to making our installation and service 
appointments fit your schedule. Installation appointments are 
scheduled at your convenience for a four-hour window. Repair 
appointments are scheduled for a specific time. In either case, if  
for any reason we’re not there within 30 minutes of the close of the 
scheduled appointment, you’ll receive a $20 credit on your next bill.

Rapid response

If you ever experience a problem with your online service, just call us 
any day before 6 p.m., and if it’s a problem with the Qwest® network, 
we’ll fix it the same day. Call after 6 p.m., and we’ll have it corrected 
by noon the next day. If it is determined by Qwest that Qwest is 
responsible for the problem, we will credit you for the portion of the 
monthly recurring charge for service for the period of the outage. 

One-stop shopping 
Get your Internet and local telephone service from one convenient 
source — and see all your monthly charges together on one itemized 
bill. Call 1 602-266-1700 for details and to find out about our 
convenient payment options.

Arizona Customers 
Where to send your payment:

If you’re a Qwest telephone customer and:

Your Qwest bill is over $100: 
Qwest 
P.O. Box 29060  
Phoenix, AZ 85038

Your Qwest bill is under $100: 
Qwest 
P.O. Box 29013  
Phoenix, AZ 85038

If you’re not a Qwest telephone customer:

Qwest 
P.O. Box 29025 
Phoenix, AZ 85038

Guarantees

Our service guarantees mean you can always expect the best service  
at a terrific value.
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Guarantees

Colorado Customers 
Where to send your payment:

If you’re a Qwest telephone customer and:

�����Your bill is over $100: 
Qwest RPS Center  
Denver, CO 80244

Your bill is under $100: 
Qwest 
P.O. Box 173754 
Denver, CO 80217-3754

If you’re not a Qwest telephone customer: 
Qwest 
P.O. Box 29025 
Phoenix, AZ 85038

Satisfaction  
Use Qwest Choice™ OnLine for 30 days — if for any reason you’re 
not satisfied, we’ll credit your account for your regular monthly 
charges. Installation charges are not refundable. If you ever have 
concerns about your Qwest Choice OnLine service or Qwest 
telephone services, please call us at 1 602-266-1700 and we will 
answer your questions right away. If you have a concern with your 
bill, please call us at 1 602-266-1700. We’ll be happy to explain the 
charges that have appeared on your bill, as well as investigate any 
charges you feel have been wrongly applied.

Copyright © 2006 by Qwest. All Rights Reserved.

Qwest Choice OnLine is a registered trademark of Qwest 
Communications International, Inc.

Information contained in this document is subject to change without 
notice. Qwest Communications International, Inc. and their vendors 
and affiliates assume no responsibility for any errors that may appear 
in this document, nor liability for any damages arising out of the use 
of this document. No part of this document may be reproduced in 
any form by electronic or mechanical means (including photocopying, 
recording, or information storage and retrieval) without permission in 
writing from Qwest Communications International, Inc.

N3 and N3 Residential Gateway are trademarks of Next  
Level Communications.

Other trademarks are the property of their respective owners. 
All other products or company names are used for identificatioin 
purposes only, and may be trademarks of their respective owners.

This guide is written to Release 6.2/RG 2.1 capabilities.

Version: January 2006

Terms and Conditions 

Qwest Choice™  TV services are governed by Terms and Conditions, 
which are located at qwest.com/legal. Qwest routinely updates the 
Terms and Conditions from time to time. Your continued use of the 
Service(s) constitutes your acceptance of any changes.
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Qwest Choice OnLine Features

SECTION 1

The Gateway box

When you subscribe to Qwest Choice™ TV your ETHERset is contained 
within the Gateway box and an additional modem is not required. 

The ETHERset

If you do not subscribe to Choice TV, you will need an Ethernet 
modem. This amazing little device is your new connection to the 
Internet with high-speed access that’s always one click away.  
The ETHERset replaces your modem. Because you won’t dial 
in, you won’t experience busy signals. And because you use the 
ETHERset to connect to Qwest Choice™ OnLine, you may see this 
referred to as a LAN connection (Local Area Network) by some 
Internet Service Providers (ISPs) and in software documentation.

With this advanced network and your ETHERset connection, you will 
enjoy the Internet the way you want it to be, instead of the “World 
Wide Wait” you may have experienced before. 

1 | QWEST CHOICE ONLINE DENVER/PHOENIX WELCOME KIT
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Qwest Choice OnLine Service Choice OnLine Choice OnLine Deluxe Choice OnLine Premier

Downstream data rate up to 256Kbps up to 1.5Mbps up to 3Mbps

Upstream data rate up to 256Kbps up to 896Kbps up to 896Kbps

E-mail accounts two five ten

Personal Web Space
up to 5MB storage space and  
up to 500MB transfer 
bandwidth per month

up to 20MB storage space 
and up to 1000MB transfer 
bandwidth per month

up to 25MB

Maximum number of 
computers supported

one four five

Domain hosting of e-mail 
and personal Web site

No
Vanity domain for Web site 
and e-mail convenience

Vanity domain for Web site 
and e-mail convenience

Dial-Away Roaming access* Yes Yes Yes

Qwest Choice OnLine Features

*Available in select locations in the 14-state Qwest® region. Long-distance charges may apply when you connect from outside the local calling area or from
 outside the Qwest region.

Table 1:  
Qwest Choice OnLine Features

•	� Unlimited high-speed Internet access

•	� Choice of two service levels to best fit your needs

•	� One click away

•	� Dedicated line

•	� No additional equipment needed, if you are a  
Qwest Choice TV customer
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Professional installation

Complete installation service by our professionally trained computer 
installers is available. The installation service includes:

•	� Installation of a wall jack wired to the incoming high-speed line

•	� Connection of the modem equipment

•	� Installation of a Network Interface Card (NIC) in your computer,  
if necessary

•	� Configuration of one computer’s operating system for networking

•	� Configuration of Web and e-mail software

•	 A basic tutorial on using the service

A customer self-installation option is available for qualified lines in 
some areas. Installation and network configuration to more than one 
computer is available at an additional charge.

Software suite

Wireless installation for up to five computers is available at an 
additional charge per computer.

�For a low monthly fee, you can get in-home support for your 
wireless network.

Support plus

Qwest Choice™ OnLine gives you more than just lightning-fast 
Internet access. You also receive round-the-clock technical 
customer support when you need it, 24 hours a day, 365 days a 
year, with live, professionally trained support technicians. OnLine 
support is also available via e-mail at choice@qwest.com as 
well as Help, How To and FAQs on the home page Web site.

Local customer home page

Each city where Qwest Choice OnLine is available has a dedicated 
Qwest Choice OnLine home page, with local content, Qwest Choice™ 
TV listings and useful Internet tools. This home page is also your 
link to the Account Manager, where tasks such as adding e-mail 
accounts and setting passwords can be accomplished.

Qwest Choice OnLine Features



QWEST CHOICE ONLINE DENVER/PHOENIX WELCOME KIT | � 

Features defined

Personal e-mail

Qwest Choice™ OnLine – Two Accounts 

Qwest Choice™ OnLine Deluxe – Five Accounts
Qwest Choice™ OnLine Premier – 10 Accounts

Every customer receives unique, personal e-mail accounts. Incredibly 
easy to use and reliable, e-mail is also very fast, usually taking just a 
few seconds to deliver your message. The Account Manager provides a 
simple way to update your e-mail address, change your password and 
more. E-mail addresses are in the format username@qwest.net and 
can contain from three to 16 characters for the username, which you 
can customize as you wish the first time you log in to the site. You will 
need to choose a unique username for each user account you activate.

Personal Web space

Qwest Choice OnLine –  
up to 5MB storage space,  
up to 500MB a month transfer limit

Qwest Choice OnLine Deluxe –  
up to 20MB storage space,  
up to 1000MB a month transfer limit

Qwest Choice OnLine Premier –  
up to 25MB storage space 
up to 2000MB a month transfer limit

Personal Web page space is maintained on our servers so you can 
put up several megabytes of information about you and your family, 
including pictures, letters, contact information and more. Your Web 
page is viewable by everyone on the World Wide Web.

Note: Qwest® will not allow posting of obscene or otherwise offensive 
material as determined solely at our discretion. Qwest will not 
allow posting of materials that infringe or misuse our trade names, 
trademarks or copyrights. Qwest is not responsible for the content 
of your Web site, including, but not limited to, materials that may 
infringe on others’ marks. Qwest reserves the right, at its sole 
discretion, to remove Web site content on its servers that it finds to 
be obscene, offensive or otherwise unlawful. Additional information 
is available on the Terms and Conditions page, and the Acceptable 
Use Policy is available at qwest.com/legal. 

USENET newsgroup access

Qwest Choice OnLine gives you access to discussion groups and 
bulletin boards used by people around the world. With USENET 
News, you can join discussions of over 20,000 topics, from car-buying 
to computers, investing to education and sports. If you have a hobby, 
you can almost always find others who share your interests.

Internet, FTP, Telnet and IRC

Our full-service, high-speed Internet access means that we give 
you the latest Web browser and full access to view Web pages 
on the Internet, as well as full-file transfer protocol (FTP) access 
for downloading and uploading files on the Internet. You may also 
use client software to run IRC and Telnet sessions. Note: You may 
not operate Internet servers and FTP servers on the Qwest Choice 
OnLine connection. For other usage information please review the 
Choice OnLine Terms and Conditions and the Acceptable Use Policy 
at qwest.com/legal.

Qwest Choice OnLine Features
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Dial-Away Roaming service

Your Qwest Choice™ OnLine service includes traditional dial-up 
access into the qwest.net local dial-up access ports from 
selected locations throughout the 14-state region Qwest® serves.  
This includes dial-in access when you are away from home and 
want to check your e-mail and surf the Web.*

Vanity domain name
(Qwest Choice™ OnLine Deluxe customers only)

Qwest Choice OnLine Deluxe users receive free domain name 
service for their account. Note: You are responsible for any fees 
associated with registering your domain name with InterNIC. 

Domain names are easy-to-remember words that represent 
locations on the Internet, such as www.qwest.net. If you have 
a domain name registered with InterNIC, Qwest will allow you 
to map the domain to your e-mail user accounts to create 
username@yourdomain.com, instead of username@qwest.net for 
your e-mail address. DNS service is also mapped to your personal 
home page Web space, so instead of a personal home page 
address such as: www.users.qwest.net/~username  
You will have: www.yourdomain.com.

If you do not have a domain name, you can use your Qwest  
Choice OnLine home page to order a domain name from InterNIC.  
This feature can be located by clicking on the My Account link from 
the Qwest Choice OnLine home page. If you want the service, the 
cost for the domain name (about $70) is billed directly to you by 
InterNIC. Qwest is not responsible for this process or payment.

Multiple computer access 
(Qwest Choice OnLine Deluxe customers only)

Qwest Choice OnLine Deluxe customers can have up to four 
computers per household set up for simultaneous Internet access 
(per-computer installation fees apply — call your local Qwest Choice 
OnLine service center for details). Qwest Choice OnLine customers 
are limited to one computer per household.

 *Access using dial-up numbers outside the local calling area may incur  
long-distance charges.

Qwest Choice OnLine Features
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Minimum System Requirements

SECTION 2

Windows®

•	 Pentium class processor or better

•	 166MHz processor speed or better

•	 32MB of RAM or better

•	 Functional CD-ROM drive

•	 Functional floppy drive

•	 Built-in Ethernet or available PCI expansion slot 

•	� Supported Windows operating systems: 
Microsoft Windows 98 SE 
Microsoft Windows XP 
Microsoft Windows NT 4.0 Workstation 
Microsoft Windows 2000 Professional

Macintosh®

•	 Power PC processor or better

•	 32MB of RAM or better

•	 Functional CD-ROM drive

•	 Built-in Ethernet or available expansion slot

•	 Mac OS version 9.2 or higher

The computer must be in stable operating order for the installation 
to be performed. Computers with existing chronic operating system 
or hardware problems cannot be installed until the owner resolves 
any existing issues.
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The following are not supported:
•	� Any operating system not listed above as supported. Other 

operating systems can be configured by experienced owners,  
but will not be supported by Qwest®

•	� “Multi-homed” systems (i.e., systems connected to more than  
one ISP simultaneously or with multiple Ethernet cards installed 
in them)

•	� Firewalls

•	� Third-party software

•	� Systems with existing network settings from which the customer 
will not or cannot authorize removal. Usually, this kind of 
computer is an employer-issued portable that is connected to 
an Ethernet network at the owner’s place of employment. In 
many cases, altering the settings to allow this kind of computer 
to access the Qwest Choice™ OnLine network results in an 
interruption of the computer’s ability to connect to the existing 
network at the owner’s place of employment

•	� Prerelease or beta versions of operating systems, hardware or 
application software

•	� Any computer that does not support the addition of Ethernet 
capability (i.e., no expansion slots)

Minimum Security Requirements
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System security 

Qwest is providing the information below for customer service and 
educational purposes only. Qwest assumes no liability for use of 
such information. 

Qwest gives you unrestricted access to the Internet. This means we 
have no control over what Internet content you decide to see or use. 
Qwest cannot be responsible for problems you may encounter with 
content, security and privacy on the Internet.

Staying safe when you’re on the Internet is not only important, it’s 
relatively easy to do. 

Remember, we will never ask for your password or any other 
personal information through e-mail, and neither should anyone 
else. Since you are a Qwest subscriber, we have your phone number. 
If we have a question, we will call you. If we can’t reach you, we will 
e-mail you to find a time when it is convenient to contact you. If you 
do get e-mail asking for personal information, your best course of 
action is to call us to confirm that Qwest is the one asking.

Do not accept files unless they come from someone you know 
and trust. Like the real world, there are a lot of nice people in 

cyberspace, but a few people are not so nice. And sometimes, 
even when the nice people have the best of intentions, they can
still cause you some trouble.

how qwest security compares

Qwest provides each customer his or her own dedicated connection, 
which is one of the best possible security measures on an open 
network such as the Internet. Cable modems often use network 
design where connections are shared, potentially making your 
information more vulnerable than a dedicated connection.

Parental control software

“Parental control” is the phrase often associated with software used 
to perform services such as site-blocking, language filtering and 
limited security features. Qwest feels strongly that parents should 
have as many tools as possible to ensure their children have a great, 
healthy online experience.

Internet Security

SECTION 3
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Internet Security

Giving out information 

On the Internet, you will be inundated with requests for information 
about you. Most of this information is used to provide custom-tailored 
services and products catered to your tastes. It is up to you to decide 
when and what information you release on the Net.

We recommend you set an information policy early for your family 
and household. Determine what information you will and will not 
give out. This is especially critical if you have children in your 
home. Children should never respond to requests for information 
from people or anonymous users they don’t know and that you 
have not approved. 

It is important never to give out their names, ages, addresses or 
phone numbers, no matter who asks.

Finally, we suggest you choose sites you are comfortable with before 
giving out important information. If you choose reputable sites from 
solid vendors, you are more likely to feel secure about giving out 
your personal information and credit card numbers — just like in the 
real world.

Computer viruses

Seriously damaging viruses occasionally infect the Internet. You 
should take appropriate precautions. Computer viruses are malicious 
software programs designed to interrupt, slow down, damage or in 
other ways negatively affect data on your computer. By definition, 
viruses are self-replicating and can spread to other computers. You 
don’t want one!

The best way to avoid viruses is to download and run software only 
from trusted sources.

A recent scam to get you to load a virus is to pretend to send legitimate 
update e-mail. For example, “This is the new security patch for your 
Netscape browser. Please load it immediately.” Remember, legitimate 
software providers will almost never send you software this way. They 
normally ask you to visit the site, if they ask at all.

Using credit cards online

There is a lot of concern and press coverage about the security of 
giving your credit card number to a merchant on the Internet to 
purchase goods and services. The reality is that this is as safe as 
using a credit card at such places as restaurants — and maybe 
safer. However, you always need to make a judgment regarding 
the credibility of the organization to which you give your credit 
card information.

Browser Software has built-in security, which can encrypt your 
credit card number, making it unreadable to anyone who should  
not see it.

Credit card transactions over the Internet are likely more secure 
than reading your card number to someone over the phone or 
actually handing your card to a waiter, who then disappears with  
it for a while where you cannot see him or her.

Additionally, many Internet merchants are beginning to offer 100% 
fraud protection guarantees (to supplement the $50 deductible 
normally associated with credit card fraud).
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All use of the Services will comply with the AUP, posted at  
qwest.com/legal/. Among other things, the AUP prohibits sending 
unsolicited e-mail messages, including bulk commercial advertising 
or informational announcements (collectively, “Spam”). Qwest® 
may immediately terminate or suspend any account which Qwest 
believes is transmitting or is otherwise connected with any Spam. 
Further, Qwest may hold you liable for Qwest’s actual damages in 
any way arising from, or related to, any Spam transmitted by or in 
any way connected to you or your account, to the extent such actual 
damages can be reasonably calculated. If actual damages cannot be 
reasonably calculated, you agree to pay Qwest liquidated damages 
of five U.S. dollars ($5) for each piece of Spam transmitted from or 
otherwise connected with you or your account. You will not, however, 
be liable for actual or liquidated damages arising from Spam 
generated from you or your account if you establish that the Spam 
was sent as a result of a virus or worm or other malicious software 
infection and if you have taken reasonable actions to prevent and 
resolve such infections and stop the Spam.

Acceptable Use Policy

SECTION 4
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Troubleshooting Your Computer

SECTION 5

Network setup

This section gives you step-by-step instructions for the network 
(TCP/IP) setup for the following operating systems:

•	� Windows 98, XP

•	� Windows NT 4.0 Workstation

•	� Windows 2000 Professional

•	� Macintosh OS 8.6 or higher

What you need

The following are components necessary for Internet service in  
the case of reinstallation or troubleshooting:

•	� A personal computer that meets the Qwest Choice™ OnLine 
minimum specifications 

•	� A supported operating system 

•	� A Web browser (Netscape 4 or greater, Internet Explorer 4 or greater)

•	� A working network interface card (Ethernet, 10baseT); follow 
manufacturer’s installation instructions

TCP/IP in Windows 98, XP

Where to look

Go to the Start Menu>Settings>Control Panel and double-click  
the Network icon. This will load the Network Applet Panel for 
Windows 95/98, as in Figure 1.

Figure 1
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Troubleshooting Your Computer

What to look for

Under the Configuration tab of the Network window, you  
will see a list of network components installed on your machine.  
In order for your computer to utilize Qwest Choice OnLine, you  
need two components:

•	� An Ethernet adapter. This may also be labeled “Network Adapter” 
or “NIC.” Popular brands include 3com, NetGear and Novell

•	� The TCP/IP protocol. If you only have one adapter of any kind 
installed, the TCP/IP protocol will be named “TCP/IP”

If you have another, or multiple adapters, installed in your machine 
(modem, second NIC, virtual private networking adapter), confirm that 
TCP/IP is listed and followed by the name of your Ethernet adapter 
(i.e., TCP/IP => PCI Fast Ethernet DECchip 21140 Based Adapter).
Verifying TCP/IP

If both network adapter and TCP/IP are installed, you may want 
to confirm that TCP/IP is configured correctly. Under Network 
Components Installed, select TCP/IP (for your network card).  
Then select Properties. 

Select each of the following tabs from the TCP/IP properties window 
and check configuration.

•	� Under the IP Address tab (Figure 2), select “Obtain an IP address 
automatically” (DHCP)

•	� Under the DNS Configuration tab (Figure 3), select Disable DNS

•	� Under the Bindings tab (Figure 4), uncheck any checked boxes. 
You will be prompted to confirm that you have not chosen any 
bindings and asked whether you wish to select one at that time. 
Choose No (Figure 5)

•	� Under the Gateway tab, nothing should be listed. Remove any 
entries that appear

 

Figure 2	 Figure 3

Figure 4

Figure 5

Leave other tabs with their default settings. If you made changes, 
click OK and restart when prompted. If you did not make any 
changes, click Cancel.
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Troubleshooting Your Computer

Testing your TCP/IP connection
After confirming your network settings, you can check to see 
whether you’re talking to Qwest’s online servers. If everything is 
working, you will be able to obtain an IP address. 

•	� Select the Start Menu/RUN, type “winipcfg” and click OK

•	� In the IP Configuration window (Figure 6) use the drop-down 
menu to select the name of your Ethernet card

When your computer has a connection, you will have values for 
IP Address, Subnet Mask and Default Gateway. If you do not have 
values for all three categories, it will look like Figure 7.

Figure 6

To try to obtain an address, click the Renew button and wait for your 
computer to obtain values for the three categories. If your computer 
is unable to obtain values for all three categories, your networking 
is not configured correctly or needs further service. You will see an 
error message like the one shown in Figure 8.

Figure 7

If you are unable to obtain an IP address, but you are certain your 
Ethernet card is installed properly, and your connection between 
your computer and 	the Gateway or ETHERset is good, contact the 	
Qwest® Help Desk for further assistance.

Figure 8
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TCP/IP in Windows NT 4.0 Workstation

From the Windows desktop, right-click on the Network Neighborhood 
icon and choose Properties, or go to the Network Control Panel 
(Figure 9).

Figure 9

•	� Click on the Protocols tab (Figure 10). If there are no protocols 
installed, the window will be blank. This lists all the currently 
installed networking protocols on your computer

Figure 10

•	� If TCP/IP is not already present, click on Add...to add the protocol. 
The window that opens will look like Figure 11

Figure 11

•	� Scroll down and select TCP/IP. The computer may need access to 
the Windows NT workstation CD. Once you have added TCP/IP, the 
system will return you to the Protocols tab. Click on TCP/IP, then 
click on Properties. The window that opens will look like Figure 12

Figure 12
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•	� Click on the Adapter pull-down menu and verify that the only 
adapter listed is the one you have installed or are working with.  
Remove any existing Gateway, Subnet Mask or IP address.  
Select “Obtain an IP Address from a DHCP server.” Click on the  
Advanced... button. The window that opens will look like Figure 13

Figure 13

•	� Remove any existing gateways, uncheck Enable PPTP Filtering 
and uncheck Enable Security

•	� Click OK to return to the previous window. Click on the DNS tab.  
The window that opens will look like Figure 14

Figure 14

Verify that the host name matches the computer name specified 
earlier. Remove any and all DNS server information, along with any 
domain suffix search order information.

•	� Click on the WINS Address tab. The window that opens up will  
look like Figure 15

Figure 15

•	� Remove any WINS server addresses. Leave them blank

•	� Click OK to return to the Network Control Panel, then click OK 
again to commit the changes. The computer will need to access 
the Windows NT Workstation CD. You will be prompted to restart.
Restart the computer
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Testing the TCP/IP configuration
•	� Open a command prompt. Click on the Start menu, then choose 

Run. Type “command” in the window that opens, then click OK, as 
shown in Figure 16

Figure 16

A window with a command prompt will open up (see Figure 17)

Figure 17

•	� Type “ipconfig” at the command prompt and hit ENTER. Something 
like Figure 18 will appear. Note: If the dial-up adapter is installed, 
you will see more than one IP configuration. Only pay attention to 
the Ethernet adapter and its settings

Figure 18

•	� If you get the response “No IP address” and/or “No Default 
Gateway,” try to renew the settings. Type “ipconfig/release” and 
hit ENTER. Then type “ipconfig/renew” and hit ENTER. Your screen 
should look like Figure 19

•	� If you are unable to release or renew, verify that your Ethernet 
card is installed properly and that the wiring between the Ethernet 
card and the Gateway or ETHERset is good. Contact the Qwest 
Help Desk for further assistance

Figure 19
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TCP/IP in Windows 2000 Professional

Windows 2000 should install TCP/IP by default when the Ethernet 
card is installed. To verify the presence and configuration of TCP/IP, 
right-click on the My Network Places icon and choose Properties 
from the menu that appears. The window that appears will look like 
Figure 20.

Figure 20

•	� Right-click on Local Area Connection and choose Properties from 
the menu that appears. The window that appears will look like 
Figure 21

Figure 21

•	� If “Internet Protocol (TCP/IP)” does not appear, then click on the 
Install... button to add it. The window that appears will look like 
Figure 22

Figure 22

•	� Click on Protocol to select it, then click on Add... The window that 
appears will look like Figure 23

•	� Click on TCP/IP to select it, then click on the OK button to 
proceed. (In Figure 23, TCP/IP is not in the list because it has 
already been installed. On a computer without TCP/IP installed,  
it will be an option)

Figure 23
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Depending on the state of the operating system, you may or may not 
be prompted to restart after the system is done copying files. If you 
are not prompted to restart, it should be possible to proceed with 
TCP/IP configuration.

•	� From the window shown in Figure 24, double-click on Internet 
Protocol (TCP/IP). The window that appears will look like  
Figure 25

Figure 24

•	� Select “Obtain an IP address automatically” and “Obtain DNS 
server address automatically”

Figure 25

•	� Click on the Advanced... button. The window that appears will 
look like Figure 26 

Figure 26

•	� Click on the DNS Tab. The window that appears will look  
like Figure 27

Figure 27
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•	� Verify that there are no entries in any of the text boxes on this 
tab. Click on the WINS tab. The window that appears will look like 
Figure 28

•	� Verify that there are no entries in the WINS Addresses text box 

•	� Click OK when you are done. Click OK on the remaining windows 
to exit back to the desktop. You may be prompted to restart

Figure 28

Testing the TCP/IP connection

To open a command prompt, click on the Start menu, then choose 
Run. Type “command” in the window that opens (Figure 29), then 
click OK.

Figure 29

A window with a command prompt will open up, as shown in Figure 30

Figure 30

•	� Type “ipconfig” at the command prompt and hit ENTER. Your 
screen should look like Figure 31. Note: If the dial-up adapter is 
installed, you will see more than one IP configuration. Only pay 
attention to the Ethernet adapter and its settings

•	� If the message “No IP address” and/or “No Default Gateway” 
appears, try to renew the settings

Figure 31
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•	� Type “ipconfig / release” and hit ENTER. Then type “ipconfig / 
renew” and hit ENTER. The screen will look like Figure 32

•	� If you are unable to release or renew, verify that your Ethernet 
card is installed properly and that the Gateway or ETHERset is 
connected. If you need further assistance, contact the Qwest®  
Help Desk

Figure 32

TCP/IP in Mac OS 8.6 or higher

Be sure TCP/IP is installed and configured on your computer. 
TCP/IP is the networking protocol that allows your computer to 
communicate with the Internet.

In order to configure TCP/IP on a Macintosh, you must have either 
Open Transport or MacTCP installed. You must also have a built-in 
Ethernet or a third-party Ethernet card and its associated drivers 
installed in your Macintosh. 

•	� Go to the Apple Menu, select Control Panel, and select TCP/IP or 
MacTCP

•	� In the TCP/IP or MacTCP/More window, select or enter information 
as shown in Figure 33:

Figure 33

	 - Connect Via: Ethernet 

	 - Configure: Using DHCP

	 - DHCP Client ID: Enter username

	 - IP Address: Will be automatically assigned

	 - Subnet Mask: Will be automatically assigned

	 - Router Gateway Address: Will be automatically assigned

	 - Domain Name server address: Will be automatically assigned

	 - Starting domain name: Not able to change

	 - Ending domain name: Leave as is

•	� Close the TCP/IP Control Panel and click Save to save the settings.  
If you are using Open Transport, you do not need to restart, 
although in some cases it may be necessary
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SECTION 6

Your e-mail account

With your Qwest Choice™ OnLine service you can have more than 
one e-mail box within one Qwest Choice OnLine account. Additional 
e-mail boxes are known as subaccounts or secondary accounts.

Qwest Choice OnLine service includes two e-mail boxes.

Qwest Choice OnLine Deluxe service includes five e-mail boxes. 

Adding a new e-mail box

Use this process either to add your free mailboxes or to purchase 
extra e-mail boxes. There are two steps to adding an e-mail box: 

1.	�Report the new e-mail box to the Qwest Choice OnLine server 
using the Account Manager. 

2.	Make changes to configure the new e-mail box on your computer. 

Instructions for these steps follow.

Step One: Report the new e-mail box to the Qwest 
Choice OnLine server

•	� To open the Account Manager, go to the Qwest Choice OnLine 
home page that was specified during your installation. Click My 
Account, then click Account Manager

•	� The system will ask for a username and password. Be sure to 
sign in with the primary username and password; this is the only 
account that has the ability to create subaccounts

•	� Click the Add Subaccount button. If you have already added the 
e-mail subaccounts that are free with your service, a screen will 
appear about purchasing additional e-mail subaccounts

•	� Otherwise, enter information as requested. Write down the new 
username and password, and keep them in a safe place. Be  
sure to write down the exact username and password you enter, 
paying special attention to uppercase and lowercase letters. 
Within 30 minutes, your new account will be able to send and 
receive e-mail

Step Two: Create the additional e-mail box on  
your computer

Which instructions you follow to create the additional e-mail box on 
your computer depends on whether you have Netscape or Outlook 
Express. Instructions for each of these follow.
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NETSCAPE

Setting up a user profile 
•	� Windows 98/NT/2000/XP: Click the Start button on your task bar. 

Select Programs, then Netscape Communicator, then Utilities, 
then User Profile Manager

•	� Macintosh: Inside the Netscape Communicator folder, double-click 
User Profile Manager. Create a new profile (for all operating systems)

With the User Profile Manager open, complete the following eight steps.

1. Click New and follow the instructions given on each screen. 

2.	�On the second screen, click Yes to answer the question “Will you  
be using the same Internet account as another profile?” 

3. �On the third screen, enter your name and the username you 
selected when you added a new e-mail box in Account Manager.  
Then click Next.

4. �The profile will automatically be named with the subaccount  
username you just entered. If you wish, you may change the  
profile name. Note: Even if you change the profile name, the  
username will remain unchanged on the system. Click Next. 

5.	�Click Mail Server under Mail & Newsgroups. In both the Incoming 
Mail Servers box and the Outgoing Mail (SMTP) Server box, select 
Mail and enter the server information you recorded, such as  
“pop. dnvr.qwest.net”. Now each of these two boxes should 
contain only an address such as pop.xxxx.qwest.net (where “xxxx” 
is four letters specific to the server in your area). 

6.	�Under Mail & Newsgroups, click Newsgroup Servers. Replace the 
word “news” with “news.qwest.net”. Now the Newsgroup Servers 
box should contain only “news.qwest.net”. 

7.	�On the following screen, you will be asked to select the Internet  
 account you wish to use for this profile. Your original or primary  
 account should already be selected. Click Next.

8.	�The final screen instructs you to use the Start Communicator 
button to launch Netscape Communicator with your new profile. 
Please note: If you are not presently connected to Qwest Choice 
OnLine, you will need to quit Netscape Communicator and then 
connect. Once you are connected, restart Netscape Communicator 
and select your newly created profile. You have now completed 
the Netscape User Profile setup for your new subaccount.

Remember: It takes up to 30 minutes for a new account to be ready 
to send and receive mail. If you try to access the account before it is 
ready, the Qwest Choice OnLine server will not recognize it.

Troubleshooting

If you have already created a new profile for the additional e-mail 
box and are unable to access mail or news, you must modify your 
Netscape Preferences as follows. 

1. �Open Netscape Communicator using your original user profile or 
primary account. (If you have a qwest.net icon on your desktop, 
click Connect to open Netscape Communicator.) 

2. Under the Edit menu, select Preferences. 

3. �In the Preferences window, click on the plus sign (+) or triangle to 
the left of the title to expand the Mail & Newsgroups menu. 

4. �Click Mail Server under Mail & Newsgroups. Mail server settings 
will appear to the right. 

5. �Write down the information in the Outgoing Mail (SMTP) Server 
and Incoming Mail Server boxes. (Note: The information should be 
the same in both boxes, such a pop.dnvr.qwest.net.)

6. Click Cancel. Quit Netscape Communicator. 

7. �Open Netscape Communicator again, this time using your new 
profile or new subaccount.
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8. �In Netscape, from the Edit menu, select Preferences. Again 
expand the Mail & Newsgroups menu by clicking on the plus sign 
(+) or triangle to the left of the title. 

9. �Click Mail Server under Mail & Newsgroups. In both the Incoming 
Mail Server box and the Outgoing Mail (SMTP) Server box, select 
mail and then enter the server information you recorded, such as 
“pop.dnvr.qwest.net”.

 10. �Under the Mail & Newsgroups category, click Newsgroup 
Servers. Replace the word news with “news.qwest.net”.  
Now the Newsgroup Servers box should contain only  
“news.qwest.net”. 

 11. �Click OK. The preferences window will save your changes  
and close. 

Outlook Express 4.0

Once you have created an additional e-mail box, your new account 
on the server will be ready within 30 minutes. To access that new 
account, you must enter settings into Outlook Express on your computer.

Recording server information

Before setting up your new account in Outlook Express, you  
must first record your incoming and outgoing server information  
as follows. 

1.	Open Outlook Express. 

2.	From the Tools menu, select Accounts. 

3.	In the Internet Accounts window, click the Mail tab. 

4.	Select your primary account from the list. Click Properties. 

5.	�Select the Servers tab. Write down the information in the  
Outgoing Mail (SMTP) and Incoming Mail (POP3) boxes. Note:  
The information should be the same in both boxes. An example  
of what you will see is “pop.dnvr.qwest.net”. 

6.	Click OK.

Setting up an account 

To set up an account in Outlook Express, complete the following steps.

1.	�In the Internet Accounts window, click the Mail tab. Click Add  
and select Mail. This will launch the Internet Connection Wizard. 

2.	�In the Internet Connection Wizard window, enter the following 
information where prompted.

	 a.	�Your Name: Enter the full name for your additional e-mail 
account in the Display name box. Click Next. 

	 b.	�Internet e-mail Address: Enter the e-mail address for your  
additional e-mail account in the E-mail address box. Click Next.

	 c.	�E-mail Server Names: Select POP3 for the incoming mail server 
type. Enter the mail server information you recorded earlier in 
the Incoming Mail (POP3 or IMAP) server and Outgoing Mail 
(SMTP) server boxes. Note: The information should be the same 
in both the incoming and outgoing mail server boxes, such as 
“pop.dnvr.qwest.net”. Click Next.

	 d.	�Internet Mail Log on: Select “Log on using:” and enter your 
additional e-mail account’s username in the POP account name 
box. Enter the password in the Password box. Click Next.

	 e.	�Friendly Name: Clear the Internet mail account name box  
and enter the full name for the additional e-mail account.  
Click Next.

	 f.	� Choose Connection Type: Select “Connect using my phone line” 
and click Next.
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g.	�Dial-Up Connection: Select “Use an existing dial-up connection” 
and select the primary account’s qwest.net connection.  
Click Next.

3.	�CIick Finish to close the Wizard. Your new e-mail account will now 
appear in the Internet Accounts window. Click Close.

Changing your account password

To change your Qwest Choice OnLine password, complete the 
following steps.

1.	�From your network home page (see the My Settings page for the 
address for your locale specific homepage), click on the blue My 
Account icon, located below the selection bar.

2.	Click on Account Manager.

3.	Log on using your primary account username and password.

4.	Select the e-mail account that the new password will pertain to.

5.	Click on the Change Password button.

6.	Click in the first box.

7.	�Type in the new password. Note: Check that the password meets 
the requirements.

8.	Click on the second box.

9.	Type in the new password a second time.

10.Click on the Submit button.

At this point the password has been submitted. Allow up to 30 
minutes for this change to take effect. The previous password will 
continue to be valid until the new password takes effect.
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SECTION 7

Understanding Newsgroups

Newsgroups provide access to information on any topic of interest. 
This section helps you set up and manage newsgroups using your 
Web browser. 

Newsgroups in Netscape Messenger 

Reading newsgroups can be done from Netscape’s Messenger, the 
same interface used for your e-mail. 

Set your preferences to use the qwest.net news server as follows. 

1.	Go to Edit -> Preferences... 

2.	Select Mail & Newsgroups. 

3.	Select Newsgroup Servers. 

4.	�If news.qwest.net is not listed as your server, select Add...and 
enter news.qwest.net. You do not need to set the Port or the 
checkboxes for the SSL or “Always use name and password”.  
We do not require a secure connection or that you log on, so  
leave those boxes unchecked. 

5.	Click the OK button. 

6.	�If this is the only newsgroup listed, it will be your default. If not, 
you can set this as your default by making sure news.qwest.net is 
highlighted and clicking the Set as Default button. 

7.	�Select the OK button to save the settings and close the 
Preferences window. 

8.	�To see what newsgroups are available, open your e-mail and go 
to File -> Subscribe....

Note: The first time that you choose this, Netscape will download 
the names for all 35,000+ newsgroups. Depending on your access 
speed, it may take approximately 10 minutes for this to finish.
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Finding and subscribing to newsgroups

To find newsgroups you are interested in, complete the following steps: 

1.	Select the Search tab. 

2.	Enter a subject in the Search For box. 

3.	Click the Search Now button. 

For example, a search for “antiques” might return:
	 alt.antiques.delaware.joe
	 rec.antiques
	 rec.antiques.bottles
	 rec.antiques.marketplace
	 rec.antiques.radio+phono

To subscribe to a newsgroup, complete the following steps. 

1.	�Select the newsgroup you are interested in, such as  
“rec.antiques.bottles”. 

2.	�Click the Subscribe button. (You can subscribe to additional 
newsgroups following these two steps.) 

3.	�Click the OK button when you are finished selecting all the  
newsgroups you would like to subscribe to. Unsubscribing  
from a newsgroup.

Reading and participating in newsgroups

To read the newsgroup from your Netscape Messenger window, 
which is where you may also read your e-mail, complete the 
following steps:

1.	Select news.qwest.net. 

2.	�Scroll down to the name of the newsgroup you subscribed to 
(such as “rec.antiques.bottles”) and click on it. 

3.	Click the Download button. 

Note: If you do not see news.qwest.net or your subscribed 
newsgroups, click on the plus sign. You can read and post messages 
and reply to e-mail the same way: 

•	� To send to the newsgroup, click the Reply button. Using the pull-
down menu (right-click the mouse), select Newsgroup (Ctrl+R) 

•	� To respond to the person, press the Reply button. Using the  
pull-down menu (right-click the mouse), select Sender Only

•	 To respond to both, press the Reply to All button

For more help with newsgroups and Netscape, try the following: 

1.	Select Help from the top right on your Netscape browser.

2.	Select Help from the pull-down list.

3.	Choose Newsgroups for more information on using newsgroups. 

Unsubscribing from a newsgroup

To unsubscribe from a newsgroup, complete the following steps:

1.	Go to File -> Subscribe.... 

2.	Select the group you wish to unsubscribe from. 

3.	�Click the Unsubscribe button. When the check turns into a dot, 
you know that you have unsubscribed. 

4.	Click the OK button when you are finished.
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Newsgroups in Microsoft  
Outlook Express 

Reading newsgroups can be done from Outlook Express, the same 
interface used for your e-mail. 

Getting started

Set your preferences to use the qwest.net news server as follows:

1.	Within Outlook Express, go to Tools -> Accounts. 

2.	Select the News tab. 

3.	�If news.qwest.net is not listed as your server, click Add ->  
News... followed by Internet Connection Wizard. 

4.	�Enter the name you want to use when you post a message or 
send e-mail and click the Next button. 

5.	�Enter an e-mail address so people can reply to your e-mail 
message and click Next. 

6.	�Enter news.qwest.net when prompted for your News (NNTP) 
Server. We do not require that you log on, so leave that box 
unchecked and click Next. 

7.	Click Finish to save your changes. 

8.	�If this is the only newsgroup listed, it will be your default 
newsgroup. If others are listed, you can set this as your default  
by making sure news.qwest.net is highlighted and clicking the  
Set as Default button. 

9.	Click Close. 

 10.	Click Yes to download newsgroups.

Note: The first time that you choose this, Outlook Express will 
download the names for all 35,000+ newsgroups. Depending on your 
access speed, it may take approximately 10 minutes for this to finish.

 11. Click the OK button to close the window. 

Finding and subscribing to newsgroups

Once you finish setting your preferences, the news server should 
appear as a folder in Outlook Express. The folder will be labeled: 
news.qwest.net.

To find newsgroups you may be interested in, complete the 
following steps.

1.	Click on news.qwest.net. 

2.	�If you are not already subscribed to any newsgroups, Outlook 
Express will ask you if you want to see a list of available 
newsgroups. Click the Yes button. 

3.	Find newsgroups you are interested in.

4.	�Once you see the list of newsgroups, you can search for a topic 
that you are interested in by typing the subject of interest into 
the “Display newsgroups” box near the top of the Newsgroups 
Subscriptions window.

5.	�Enter a subject in the Display newsgroups box. Note: Outlook 
Express Version 5.0 will begin searching after you type in your 
subject. For example, a search for “antiques” might return:

		  alt.antiques.delaware.joe
		  rec.antiques
		  rec.antiques.bottles
		  rec.antiques.radio+phono
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To subscribe to a newsgroup, complete the following steps. 

1.	�Select the newsgroup you are interested in, such as  
rec.antiques.bottles.

2.	�Click Subscribe. (You can subscribe to additional newsgroups by 
repeating these two steps.) 

3.	�Click OK once you have subscribed to all the newsgroups that 
interest you. 

Reading and participating in newsgroups

Read the newsgroup as you would your e-mail within Folders:

1.	�Using Outlook Express, scroll down to the name of the newsgroup 
you subscribed to (rec.antiques.bottles) and double-click on it. 

2.	�Using Internet Explorer, select Tools -> Mail and News -> Read 
News. This will open Outlook Express. 

3.	�Scroll down to the name of the newsgroup you subscribed to 
(e.g., rec.antiques.bottles) and double-click on it. 

You can read and post messages just like you read and reply  
to e-mail: 

1.	To send a message to the newsgroup, click on Reply Group. 

2.	To respond to the person, select the Reply button.

Unsubscribing from a newsgroup

To unsubscribe from a newsgroup: 

1.	�In Outlook Express, double-click on news.qwest.net from  
your Folders. 

2.	Click the Newsgroup button. 

3.	Click the Subscribed tab. 

4.	Click the group you wish to unsubscribe from. 

5.	Click the Unsubscribe button. 

6.	Click OK. 

Help

For more help with newsgroups and Outlook Express: 

1.	Select Help from the top right on the Outlook Express toolbar. 

2.	Click Contents and Index. 

3.	Click the Contents tab. 

4.	�Choose Viewing and Posting to Newsgroups to bring up more 
information on using newsgroups.



29 | QWEST CHOICE ONLINE DENVER/PHOENIX WELCOME KIT

Using Your Web Space

SECTION 8

Understanding Web space

With your Qwest Choice™ OnLine account you can publish your own 
Web pages using an FTP client, Microsoft Internet Explorer, Microsoft 
FrontPage 98, Microsoft FrontPage 2000 or Netscape Composer. You 
can also edit your Web pages locally or directly on the server, and 
get information on your disk space.

Important: Only the primary account user can create a Web 
space and publish pages. The primary account is the one that was 
designated as primary during your installation. 

Note: Qwest® will not allow posting of obscene or otherwise 
offensive material, as determined solely at our discretion. Qwest 
will not allow posting of materials that infringe or misuse our trade 
names, trademarks or copyrights. Qwest is not responsible for the 
content of your Web site, including, but not limited to, materials that 
may infringe on other’s marks. Qwest reserves the right, at its sole 
discretion, to remove Web site content on its servers that it finds to 
be obscene, offensive or otherwise unlawful. Additional information 
is available on the Terms and Conditions page. 

FTP and HTTP support

In addition to supporting hypertext transport protocol (HTTP), Qwest 
Choice OnLine supports File Transfer Protocol (FTP). You may use 
either method to publish and modify your Web pages on the  
qwest.net Web site server. 

Getting started

Before you can publish your first Web page, you will need to create 
your Web space on our server. 

1. From your locale-specific home page, click on My Account. 

2. �Click on the link Create Your Web Space. Sign in using your 
primary username and password, and follow the instructions on 
that page. 

3. �Be sure that you have the URL for your Web space on hand, 
because you will need this to upload your page. The format of 
your URL should be http://www.users.qwest.net/~username.

Next, create the name index.html for your main Web page (this is so 
that your main Web page will automatically load when the address 
for your Web site is entered). Other pages you create that are linked 
to this main page may be named anything. 
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Publishing your Web pages 

Using FTP (Experienced Users) 

Qwest.net offers FTP access to our Web server. We will set up your 
primary account username and password on our FTP server to allow 
you to access your Web site files.

Use the following information to configure your FTP client or software:

•	� Host name (or Host): ftp.users.qwest.net 

•	� User name: Your primary account username 

•	� Password: Your primary account password 

When you have successfully connected to the qwest.net  
FTP server, you will see the message “Welcome to qwest.net  
FTP Web Publishing.”

You can now use your FTP software to manage the files in your 
qwest.net Web space.

The qwest.net Web page server will disconnect after 15 minutes 
of inactivity. Depending upon your FTP client software, you may 
increase this setting to a maximum of 60 minutes. As long as you 
remain active, the FTP server will maintain the connection.

Using Microsoft FrontPage 98 

Qwest.net now supports Microsoft FrontPage 98 extensions. Follow 
these instructions:

1.	In FrontPage Explorer, open the Web site that you want to publish.

2.	�Click the Publish button on the FrontPage Tool bar. The dialog box 
appears in Figure 45.

3.	�Add the URL to publish your site as shown, making sure to add 
your username after the tilde (~):  
http://www.users.qwest.net/~yourusername.

Figure 45

4.	�Do not click the Secure connection required (SSL) box. (SSL is not 
currently supported in the qwest.net environment.) 

5.	�Enter your username and password (the same username and 
password you use to access qwest.net). 

6.	Click OK. 

The Publish FrontPage Web dialog box will close and there will be a 
pause as FrontPage contacts the Web server. Note: FrontPage now 
begins copying all your Web site files from your computer to the Web 
server. Depending on the size of your Web site and the speed of your 
Internet connection, this process may take a few minutes.

After your files have been copied, the FrontPage Status Bar will 
display the message “Published to,” followed by the destination URL. 
Your site is now ready to view.

To view your Web site you can either: 

1.	�Open a browser and type in your site URL  
(e.g., http://www.users.qwest.net/~yourusername/) or

2.	�Open the site by highlighting the site from FrontPage Explorer  
and double-clicking.
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Using Microsoft FrontPage 2000

Qwest.net supports Microsoft FrontPage 2000 extensions. In addition 
to the following instructions, FrontPage FAQs are also available.

1.	�In Microsoft FrontPage, open the Web site that you want  
to publish.

2.	�Select File -> Publish Web, or click the Publish Web icon on the 
FrontPage toolbar. The dialog box shown in Figure 46 will appear.

3.	�Add the URL address to publish, using the format  
http://www.users.qwest.net/~yourusername.

4.	�Click the appropriate radio buttons to publish or update your  
Web site.

5.	�“Publish changed pages only” is the default. This feature will  
publish your entire site the first time. 

Figure 46

6.	�“Publish all pages” overwrites pages already published.  
This feature is used to update your entire site. 

7.	�“Include subwebs” should be checked if you have any on  
your Web site.

8.	�Do not select Secure connection required (SSL is not currently 
supported in the qwest.net environment).

9.	�Enter your username and password (the primary username  
and password).

 10.	Click Publish.

Note: A status dialog box will appear that tells you what is going  
on. When you update your Web site, a FrontPage dialog box notifying 
you that a file you are publishing will replace a current file on the 
server will appear and ask whether that is what you want to do. The 
size of your Web site files will determine the time it takes for your 
Web site to update. It could take several minutes.

Figure 47

Once all the files are published, the dialog box shown in Figure 47 
will appear. Clicking on the hyperlink opens your Web site in your 
default browser. Clicking the Done button takes you to the FrontPage 
screen you used to publish your site. 

Using Netscape Composer

You can create your own Web pages using Netscape Composer. This 
software is built into the Netscape software you installed. You can 
create Web pages that include pictures and links to your favorite 
Web pages.

Consult Netscape’s NetHelp for Netscape Composer if you have 
questions about creating your Web site using Composer. (This can 
also be found under “Help Contents” in Netscape’s Help menu.)



Publish your new Web site by clicking the Publish button. Then fill in 
the dialog box (Figure 48) as follows: 

1.	�Page Title: Enter what you want to show in the top bar of your 
Netscape Browser. 

2.	�HTML Filename: Name your file index.htm if you want your page 
to automatically display when someone enters your URL.

3.	�HTTP or FTP location to publish to:  
Enter http://www.users.qwest.net/~icservices1/index.htm 

4.	Username: Enter your primary username.

Figure 48

5.	�Password: Enter your password. (Click the Save Password box 
so you don’t have to re-enter your password for every file 
you upload.) 

6.	�Files associated with this page: Make sure the button is selected 
if you are using any graphics on your page. Click the OK button.

Using Web Site Manager

You can use your FTP software or you can use the Web Site Manager 
to see how large your files are and how much space remains.

1.	�Open the Web Site Manager (click the My Account link from  
the home page).

2.	�Click Maintain Your Web Site to view your file sizes and  
disk space. 

Deleting a Web page

1.	�Open the Web Site Manager (click the My Account link from your 
locale-specific home page).

2.	Click Maintain Your Web Site. 

3.	�Enter the username and password of your primary account.  
(Only primary account users can delete Web pages.) 

4.	�To delete a file, click in the box located to the left of the file name 
in the Delete column. (You may delete files one at a time or select 
several files to delete.) 

5.	�Once you finish selecting the files you want to delete, click on  
the Delete Selected Files button. 

6.	�A delete confirmation screen will appear. Double check the list  
of files you marked for deletion. Files accidentally deleted cannot 
be restored. 

7.	�If the delete list is correct, click Yes to delete the files. Otherwise, 
click No to cancel the delete request. 

8.	�After the delete request is complete, the Web Site Manager will 
display a list of the files that remain. 

9.	�When you are finished deleting files, click the Back button, close 
the window, or go to a new URL location.

Using Your Web Space
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SECTION 9

Q:	Will I miss any e-mail messages while my computer is off? 

A:	�Absolutely not. Just like the brick-and-mortar post office, our 
mail system works around the clock to receive your mail when it 
arrives. Just as you don’t have to be at your mailbox when a letter 
arrives, your computer doesn’t have to be on to receive mail. E-mail 
messages remain in your electronic mailbox on the qwest.net 
server until you turn on your computer and check your e-mail. Then 
your mail is sent to and stored on your computer for you to read, 
print and delete, as you like. 

Q:	Does everyone in the family have to share the same e-mail? 

A:	�No! You receive separate e-mail accounts in association with one 
primary account. See Section 1 for more information.

Q:	How do I get my e-mail?

A:	�As soon as you install and configure your e-mail service 
information, you are able to receive e-mail with the primary 
account you registered, at the e-mail address you chose. 
Instructions follow on how to check your e-mail and  
e-mail settings. 

HOW TO CHECK YOUR E-MAIL USING NETSCAPE MESSENGER:
Double-click the Netscape Navigator icon on your desktop to 
open your browser. In the Communicator menu, select Messenger 
Mailbox. Click the Get Messages button. The server will ask for 
your password.

Any outgoing messages in your outbox will be sent. New e-mail 
messages will then be delivered to your computer for you to 
read, print and delete at your convenience. Once you receive 
your messages, they are on your computer, so you can read  
them and compose replies at your leisure without tying up your 
network connection.

HOW TO CHECK YOUR E-MAIL USING OUTLOOK EXPRESS: 
Open Outlook Express (open it from the Programs menu or 
double-click the Outlook Express icon). Click the Send and 
Receive button. The server will ask for your password.
Any outgoing messages in your outbox will be sent. New e-mail 
messages will then be delivered to your computer for you to 
read, print and delete at your convenience. Once you receive  
your messages, they are on your computer, so you can read  
them and compose replies at your leisure without tying up your 
network connection.
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IF YOU ARE HAVING TROUBLE RECEIVING YOUR E-MAIL: 
You may want to check your e-mail settings. Your e-mail settings are 
configured properly at the time of registration/installation and would 
not have changed without your specifically changing them. Exercise 
caution with e-mail settings, and do not make any changes you are 
not completely certain about.

Q:	Is my identity protected while I’m using the Internet? 

A:	�Qwest.net does not make any of your account information 
available for public access. But you’re free to pass around any 
information about yourself that you wish to share with other 
Internet users. We recommend that you exercise great caution 
when giving out private information because that information  
can travel quickly.

Q:	What do I do if I need to reinstall my software?

A:	�If you purchase another computer or would like to use your 
existing qwest.net account from additional computers, you may 
reinstall from the same CD you initially used. Follow the browser 

installation instructions in this guide.



35 | QWEST CHOICE ONLINE DENVER/PHOENIX WELCOME KIT

Frequently Asked Questions

Q:	�When using Dial-Away Roaming, why do I sometimes have 

trouble connecting to the Internet? 

A:	�One possible reason may be that your modem is not connecting  
at a stable rate. An effective solution is entering three commas 
(,,,) after the dial-in number in your dialer. You can also check 
to see that your connection set-up is configured correctly. 
Instructions vary depending on the software that you have:

WINDOWS 98/XP 
1.	�Double-click the My Computer icon on your desktop, and  

then double-click the “Dial Up Networking” icon. 

2.	�Right-click the qwest.net dialer connection and select 
“Properties.” 

3.	�Select the General tab. In the Phone number box, click after  
the dial-in phone number and enter three commas (,,,) after  
the number. 

4.	�Select the Server Types tab. Make sure that only the Enable 
software compression and TCP/IP check boxes are selected. 

5.	Click OK. 

WINDOWS NT 4.0

1.	�Double-click the My Computer icon on your desktop, and then 
double-click the Dial Up Networking icon. 

2.	�Select the drop-down arrow next to the Phonebook entry and 
select the dialer connection you would like to change from 
the drop-down list. Click More and then click Edit entry and 
Modem properties. 

3.	�Select the Basic tab. In the phone number box, click after  
the dial-in phone number and enter three commas (,,,) after  
the number. 

4.	�Select the Server tab. Make sure that only the Enable software 
compression and TCP/IP check boxes are selected. 

5.	�Click OK. Click Dial to save the change and connect to  
qwest.net. 

6.	�From the File menu, select Configuration. Select the dialer for 
qwest.net from the list, which makes this dialer active.



MACINTOSH
1.	�Open the Apple menu. Select Control Panels and then 

select Remote Access. (If you are running an OS version 
earlier than 8.5, you will not see Remote Access as an 
available selection. Use the instructions that follow these 
for the Free PPP Set-up selection.) 

2.	�The Remote Access window appears for the dialer that 
is active. In the Number box, click after the dial-in phone 
number and enter three commas (,,,) after the number. 
Click Save. 

For users running an OS version 2 earlier than 8.5: 

1.	�Open the Apple menu. Select PPP Set-up or Free PPP  
Set-up — make sure the arrow points down. 

2.	�On the General tab, make sure the Allow Applications to 
Open Connection and Disconnect if Idle (this is optional) 
options are checked.

3.	�Click the Accounts tab: the label should show qwest.net or 
your username (yourname@qwest.net). 

4.	Select Edit. 

5.	For Server Name choose qwest.net. 

6.	Make sure the local dial-in number is correct. 

7.	Click OK. 

8.	Click the General tab again. Select TCP IP. Click OK.  

9.	Restart your computer and try connecting again. 

Q:	Where do I find a list of local dial-in numbers? 

A:	�From the default Qwest Choice™ OnLine home page,  
click on the Help link.

Q:	How do I link my domain name to my qwest.net account? 

A:	�You must be a Qwest Choice OnLine customer  
with an active user ID and password in order to use your 
own domain.  
You can get to this information by clicking on the My Account 
link from the default Qwest Choice OnLine home page.  
Choose Link Your Domain Name to Your Web Site, sign in 
using your primary username and password and follow the 
instructions that appear.

Q:	I do not remember my password. What should I do? 

A:	�Most questions can be answered in the changing your 
password and changing your Username Help sections. If you 
are still having problems, please contact technical support.

Frequently Asked Questions
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